
1 
© Materials License 

   

Essentials 



2 
© Materials License 

 
Copyright © Blackboard Collaborate 
09012011All Rights Reserved. 
 
The content of this manual may not be reproduced or distributed without the express 
written consent of Blackboard Collaborate Inc. Users acknowledge that the manual, and 
all copyright and other intellectual and proprietary rights therein, are and at all times, 
shall remain the property of Blackboard Collaborate Inc. and its licensors, and their 
respective assignees. Users agree to respect and not to alter, remove, or conceal any 
copyright, trademark, trade name, or other proprietary marking that appears in this 
manual.  
  



3 
© Materials License 

Contents 
 
Essentials Workshop… At-a-Glance .......................................................................... 5 

Part One: Getting Started ............................................................................................ 6 

Blackboard Collaborate Overview ....................................................................... 6 

Readiness Checklist: ........................................................................................... 6 

What is Blackboard Collaborate? ........................................................................ 6 

What are the Technical Requirements for Blackboard Collaborate? .................... 6 

How Do I Get Started? ........................................................................................ 7 

Connection Speed ............................................................................................... 7 

Audio Setup Wizard ............................................................................................. 8 

Profile .................................................................................................................. 9 

Part Two: Orientation to the Room ........................................................................... 10 

Blackboard Collaborate – Participant View ........................................................ 10 

Blackboard Collaborate – Moderator View ........................................................ 12 

Participant Checklist .......................................................................................... 14 

Test Your Knowledge: Overview ....................................................................... 15 

My Notes ........................................................................................................... 17 

Part Three: Communication Methods ....................................................................... 18 

Non-Verbal Communication .............................................................................. 18 

Audio ................................................................................................................. 18 

Live Video ......................................................................................................... 18 

Chat .................................................................................................................. 18 

Practice: Communication Skills ......................................................................... 19 

Test Your Knowledge: Communication .............................................................. 21 

My Notes ........................................................................................................... 22 

Part Four: Classroom Interaction ............................................................................. 23 

Test Your Knowledge: Classroom Interaction .................................................... 24 

My Notes ........................................................................................................... 26 

Part Five:  Polling....................................................................................................... 27 

Practice: Polling ................................................................................................ 28 

Test Your Knowledge: Polling ........................................................................... 29 

  



4 
© Materials License 

 

Part Six: Session Content - PowerPoint and the Whiteboard ................................. 30 

Whiteboard ........................................................................................................ 30 

Whiteboard Tips ................................................................................................ 30 

Practice: Whiteboard continued… ..................................................................... 32 

Practice: Whiteboard continued… ..................................................................... 33 

Test Your Knowledge: Whiteboard .................................................................... 34 

Part Seven: Recording a Session ............................................................................. 35 

Part Eight: Tips on Leading a Session ..................................................................... 36 

Part Nine:  The Blackboard Collaborate Experience ............................................... 39 

Test Your Knowledge: Overview – Answer Key ................................................. 40 

Test Your Knowledge: Overview ....................................................................... 40 

Test Your Knowledge: Communication .............................................................. 42 

Test Your Knowledge: Classroom Interaction .................................................... 43 

Test Your Knowledge: Polling ........................................................................... 44 

Test Your Knowledge: Whiteboard .................................................................... 45 

 
  



5 
© Materials License 

Essentials Workshop… At-a-Glance 

 

Part One: Getting Started 

 Review the readiness checklist 

 Identify technical requirements 

 Identify the steps for getting started 

Part Two: Orientation to the Room 

 Understand the user interface both Moderator and Participant 

 Identify the panels, tools, and features for Participants and for Moderators 

Part Three: Communication Methods 

 Identify different methods of communication – non-verbal, audio, video, and chat 

 Identify uses for emoticons, raise hand, step away and polling 

 Use VoIP audio single talker and simultaneous talkers to effectively 
communicate during a session 

 Use the live video with single video and simultaneous video 

 Use Chat to send and receive public, private, and announcement type 
messages. 

Part Four: Classroom Interaction 

 Manage classroom interaction from the Participants panel 

 Give and take away the session permissions individually and globally.   

 Interpret the Activity Indicators and Status Indicators to manage the classroom  

Part Five: Polling 

 Change the Polling response options 

 Lock/unlock, hide/show and publish the Polling responses 

Part Six: Session Content – PowerPoint and the Whiteboard 

 Load a PowerPoint file 

 Navigate the Pages  

 Utilize the Whiteboard tools 

Part Seven: Recording a Session 

 Identify the steps for starting, pausing and stopping the session recorder 

Part Eight: Tips on Leading a Session 

 Identify steps Moderators should take before, during, and after the session to 
ensure a successful learning event 

Part Nine: The Blackboard Collaborate Experience 

 Additional Resources 

 Answer Keys 
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Part One: Getting Started 

 
As a participant in a Blackboard Collaborate session, you can interact with the presenter 
and other participants in a synchronous, media-rich environment.  Through the 
participant experience, you will gain an understanding of what your participants will 
need to know to take part in the web conferencing sessions that you conduct. 
 

Blackboard Collaborate Overview 

In Part One, we will explore Blackboard Collaborate, examine its technical 
requirements, and take a closer look at both the Participant and the Moderator 
perspectives.  First, let’s make sure you have everything you need. 
 

Readiness Checklist: 

 Training Manual 
 Headset with integrated microphone 
 Computer connected to the Internet 

 
Now that you have everything you need to complete this workshop, let’s get started. 
 

What is Blackboard Collaborate? 

 
Blackboard Collaborate™ gives you the functionality you need to support a 21st century 
teaching and learning environment, such as two-way audio, multi-point video, interactive 
whiteboard, application and desktop sharing, rich media, breakout rooms, and session 
recording. Educators and students can engage as if they were in a traditional 
classroom, with as good as, or even better, outcomes. 
 

What are the Technical Requirements for Blackboard Collaborate? 

 
Windows: 

 Supported OS’s and recommended versions of Java: 
o Windows  

 Windows XP (32 bit with 32 bit JVM) 

 Windows Vista (32 bit with 32 bit JVM ) 

 Windows Vista (64 bit with 64 bit JVM) 

 Windows 7 (32 bit with 32 bit JVM) 

 Windows 7 (64 bit with 64 bit JVM) 
o Pentium III 1 GHz processor  
o Supported Client Java Versions 

 1.5 

 1.6 (32 and 64bit)  

 32bit JVM’s with 32bit Operating System 

 64bit JVM’s with 64bit Operating System 



7 
© Materials License 

 Java Access Bridge 2.1 (Using Jaws)  
  

 Supported Browsers for use with Blackboard Collaborate 
o IE 7 
o IE 8 
o IE 9 
o Firefox 3.6+ 
o Google Chrome 3.0.15 

  
Macintosh: 

 Supported OS’s and recommended versions of Java 
o OS X 10.5 (32 bit with 32 bit JVM)  
o OS X 10.5 (64bit with 64bit JVM) 
o OS X 10.6 (64 bit with 32 bit JVM)  
o OS X 10.6 ( 64 bit with 64 bit JVM)  
o G4, G5 or Intel processor  
o Apple Java 1.5.0_16 (J2SE5 - 32 bit), Apple Java 1.6.0_07 (J2SE6 - 64 

bit)  
 

Supported Browsers for use with Blackboard Collaborate  

 Safari 4.x 

 Firefox 3.5+ 
 
In addition, all clients require: 

 256 MB of free RAM  
 20 MB free disk space  
 28.8 kbps Internet connection  
 Speaker and Microphone, headsets are preferred  

 
For technical support please visit our Support Portal at http://support.blackboardcollaborate.com 
where you can search our knowledge base, submit a ticket, chat with a support representative 
or call our help desk. 

 

How Do I Get Started? 

There are three ways to log in to a Blackboard Collaborate session: 1) via integration 
with a Course Management System, 2) via the Session Administration System (SAS) or 
3) via a direct connection using an URL to the session.   
 
After connecting to the web conferencing session, you will need to do the following: 
1. Set your connection speed 
2. Run the Audio Setup Wizard 
3. Create a Profile 
 

Connection Speed 

The first time you join a session, the Select connection speed dialog box appears 
prompting you to select the connection speed that you will be using. After you exit the 
session, the connection speed is automatically saved with the preferences.  If you will 

http://support.blackboardcollaborate.com/
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be changing locations, for example moving from a LAN connection at work to a Wireless 
connection at home, you must change your connection speed to reflect the change in 
location.  

 
 
The Connection Speed can also be set from the Preferences menu (PC users – Edit > 
Preferences and MAC users – Blackboard Collaborate > Preferences) Visit the On-
Demand Learning Center for more detailed information. 

 
 

Audio Setup Wizard 

To verify that your audio is set up correctly, we recommend that you use the Audio 
Setup Wizard.  The wizard will allow you to select input and output devices and test 
your microphone and speakers and adjust the levels if necessary.  The wizard is located 
in the Tools menu select Audio > Audio Setup Wizard, or can be accessed through the 

 button located on the Audio & Video Panel.  A series of panels will guide you 
through the process. 
 
Q:  When should I run the Audio Setup Wizard? 
 
A:  You should run the Audio Setup Wizard each time you join a Blackboard Collaborate 
session. 
 
Q:  Should I run the Audio Setup Wizard if I make changes to my computer? 
 

http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx
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A:  Yes.  During the course of a normal work day, you might watch a YouTube video, 
unplug your headset, plug in a new peripheral, mute your microphone, turn down the 
volume on your speakers, all of these actions can impact the session audio.  
 
Q:  Should I run the wizard again if I am experiencing audio difficulties with the 
session? 
 
A:  Yes.  Your first step in resolving audio difficulties is by running the wizard. If this 
does not resolve the problem, contact Blackboard Collaborate’s 24x7 support team. Go 
to http://support.blackboardcollaborate.com to locate the Support Portal from there you 
can search our knowledge base and submit a ticket. 
 

Profile 

The User Profile feature allows users to publish information about themselves and to 
view information provided by others. The Moderator controls which profiles are 
displayed. This is done by selecting Tools > Profile > Show Profiles. The user’s profile 
appears as a pop-up in the Participants List. To view a user’s profile, hover your mouse 
over the Participant’s name. To create a profile, go to Preferences > My Profile or 
select Edit Profile from the Participants Options menu. 
  

http://support.blackboardcollaborate.com/
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Part Two: Orientation to the Room 

Blackboard Collaborate – Participant View 

 
 

What You Can See & Do 

Content Area  View presentations, images, Clip Art and annotations 

Tools Palette 

 Annotate pages 

 Place a screen capture on the page 

 Place Clip Art on the page 

Audio & Video 
Panel 

 Access Audio & Video Options menu 

 Use Expand/Collapse buttons 

 Open the Audio Setup Wizard 

 View Speaker Level indicator and use volume slider 

 View Microphone Level indicator and use volume slider 

 Use the Talk button to speak 

 Switch to a Teleconference (if enabled) 

 Use the Preview button to see a preview of your video 

 Use the Video button to transmit your video 

Participants 
Panel 

 Access Participant Options menu to detach panel 

 Use the Expand/Collapse Button 

 Send Feedback, Step Away, Hand Raise, and use the 
Polling Response options 

 View a list of Moderators and Participants 

 View User Profiles  

 View individual permissions and activity indicators 
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Chat Panel 

 Access Chat Options menu 

 Use the Expand/Collapse button 

 Send Public Chat 

 Send Private Chat (if enabled) 

 Send private messages to Moderators (even if private 
messaging is disabled) 

Menu Bar 
 Blackboard Collaborate (Mac only) File, Edit, View, Tools, 

Window, and Help 

Collaboration 
Tool Bar 

 View Whiteboard Mode button 

 View Application Mode button 

 View Web Tour Mode button 

 Access Information Menu 

Whiteboard 
Action Bar 

 View Page title 

 Adjust Zoom Value 
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Blackboard Collaborate – Moderator View 

 
 

What You Can See & Do 

Content Area 
 Load and display content – PowerPoint, Whiteboard, images, 

and Clip Art 

Tools Palette 

 Annotate screens 

 Place a screen capture on the page 

 Place Clip Art on the page 

Audio & Video 
Panel 

 Access Audio & Video Options menu 

 Use Expand/Collapse buttons 

 Click the Audio Setup Wizard button to test audio 

 View Speaker Level indicator and use volume slider 

 View Microphone Level indicator and use volume slider 

 Use the Talk button to speak 

 Switch to a Teleconference (if enabled) 

 Use the Preview button to see a preview of your video 

 Use the Video button to transmit your video 

Participants 
Panel 

 Access Global Options menu to assign permissions to 
participants 

 Use the Expand/Collapse button 

 See who has joined the session and what permissions they 
have 

 Access Participant Options menu 

 Grant or take away a Participant’s permission to use a feature 

 View Activity & Status Indicators 

 View User’s Profiles 
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 Use the Feedback, Step Away, & Hand Raise buttons 

 Use the Polling Response menu 

 Remove a Participant from a session 

 Give or take away Moderator privileges 

 Select multiple Participants to send a private message 

 Create Breakout Rooms and distribute participants to rooms 

 Invite a new attendee 

 Change Polling type 

 Lock Polling Responses 

 Make Polling Responses Visible 

 Publish Responses to Content Area 

Chat Panel 

 Access Chat Options menu 

 Use the Expand/Collapse button 

 Send public or private Chat messages 

 Send Chat announcements 

 Monitor private messages sent to other users (if enabled for 
the session) 

 View Private Chat messages 

Menu Bar 
 Blackboard Collaborate (Mac only), File, Edit, View, Tools, 

Window, and Help 

Collaboration 
Tool Bar 

 Start Application Sharing 

 Start Web Tour 

 Set the Timer 

 Load Content 

 Start the Recorder 

Whiteboard 
Action Bar 

 Create a new page 

 Delete a page 

 Clear a page 

 Adjust Zoom Value 

 Access Whiteboard Option menu 

 Navigate Pages 

 Access Go To Page menu 

 View Page Counter 

 Use Page Explorer  
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Participant Checklist 

 
Use the checklist below as a guide to become familiar with Blackboard Collaborate as a 
participant.  Use the notes section to record your observations and any tips you might 
want to share with participants in your web conferencing session. 

 

Connection Speed 

□ Explore your computer’s setup to determine your Internet 
connection.  Go to Edit (Blackboard Collaborate for Mac 
users) > Preferences > Session > Connection in order to 
match the connection speed in Blackboard Collaborate to your 
computer’s connection speed. 

□ If you are using a wireless router, did you select the correct 
option: wireless? 

□ What tip could you give a participant who may be 
experiencing connectivity issues? (Answer: Lower the 
connection speed) 

Audio Setup Wizard 

□ Run the Audio Setup Wizard. 

□ Did you experience any difficulties with your computer 
settings? 

□ What advice might you give a new user with regard to using 
the Audio Setup Wizard? (Answer: Make sure your audio has 
not been muted on the headset or computer) 

Panel Layout Options 

□ Click the View menu and deselect View Side Bar.  What did 
you notice? 

□ Click the View menu and select View Side Bar.  Did this 
restore the side bar? 

□ Click the Audio & Video panel title bar.  Drag and drop the 
panel to another area of your monitor.  Do the same for the 
Chat panel.  What can you conclude from being able to move 
these panels? 

□ Click the View menu and click Restore Default Views 

□ When you alter the default layout, the next time you enter a 
session, will the layout be switched back to the default view? 
Try it. 
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Test Your Knowledge: Overview 

 
Test your knowledge of the web conferencing interface by matching the screenshot on 
the left to its correct description on the right.  You can find the answer key in the last 
section of the manual. 
 

1 
___ 

 
 

 

A 
The moderator is able to 

grant a participant permission 
to annotate in this area. 

2 
___ 

 

 
 

 

B 
From this area moderators 

can control participant 
permissions on either an 
individual or global level. 
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Test Your Knowledge: Overview continued… 

3 
___ 

 

 

C 
From this area a participant is 

able to turn on and off their 
microphone. 

4 
___ 

 

 

D 
The moderator can start and 
pause the session recording 

from this area.  

5 
___ 

 

 

E 
Participants can send public 

and private text chat 
message in this area. 
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My Notes 
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Part Three: Communication Methods 

 
There are many similarities between communicating in a physical classroom and the 
virtual classroom.  In the physical classroom, teachers and students can talk, see one 
another and send text messages either by putting words on a whiteboard or passing 
paper notes.  Students can also raise their hands, provide feedback with facial 
expressions and respond to a teacher’s polling of the class with yes/no feedback.  The 
same thing can happen virtually.  In a Blackboard Collaborate web conferencing 
session, moderators and participants can use the session audio to speak, live video to 
see one another and chat to send text messages.  They can raise their virtual hands, 
send feedback with the emoticons and respond to a teacher’s query with the yes/no 
polling tool. 
 

Non-Verbal Communication 

A series of non-verbal communication tools are available for the moderator and 
participants in a session.  These tools can be used to communicate emotion, provide 
feedback to verbal questions, respond to something being said by the instructor or a 
participant or to indicate an attendee has temporarily stepped away from the session.   

Audio 

Session attendees participate in conversations during a session using a microphone 
and speakers (or headset) via Voice over Internet Protocol (VoIP).  In a Blackboard 
Collaborate web conferencing session, the Moderator has full control over who can talk 
during the session and how many Participants can simultaneously talk during a session.  
Alternatively, if your organization offers teleconferencing services, you can use the 
Telephony (telephone conferencing integration) feature for your in-session 
communications.  

Live Video 

The video feature of Blackboard Collaborate enables you to transmit and receive video 
broadcasts with others in a session. This is video you send live via a video camera 
(e.g., web cam) – not to be confused with a pre-recorded video (movie) that can play 
using the Multimedia feature. The video feature displays up to six simultaneous camera 
transmissions. 

Chat 

The Chat panel enables Participants and Moderators to exchange text messages with 
each other in a session. Participants can always send a message to Moderators, even if 
the Participant does not have Chat permission by simply right-clicking on the 
Moderators name and choosing the option to send a private chat or by double-clicking 
on the Moderator’s name. The message will appear as a private message only visible to 
the Moderator. 
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Practice: Communication Skills 

 

Non-Verbal Communication 

 

 Click Yes (checkmark) and then No 
(X), and notice that the Yes/No 
indicator automatically changes in 
the Participants panel. 

 

 Think about how might you use 
these tools as comprehension 
checks during an instructional 
session? 

 

 

 Click the Raise Hand button. What 
happens? 

 

 

 Click the Step Away button. What 
happens? 

 

  

 Practice using the Feedback options 
to send an emoticon. 
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Practice: Communication Skills continued… 

 

Chat Panel 

 

 Practice sending Public and Private 
Chat messages. Send a public 
message. Be sure you know how to 
distinguish the different types of 
messages. Hint: they are separated 
by conversation tabs at the bottom 
of the Chat Panel. 

 

 Practice using the Emoticon Menu 
to send an emotion via text. 

 

 Explore the Options menu to use 
the Chat feature to its fullest extent. 

Audio & Video Panel 

 

Click the Talk button to turn on the 
microphone. Practice turning on and off 
the audio, speak into the microphone 
and look for the visual clues on the 
screen that your audio is being 
transmitted. 

 

 

Practice previewing and transmitting 
Video.  
 
What do you notice when you stop 
transmitting? 
 
Practice using this feature with multiple 
talkers and videos.  What do you notice 
happens to the video when a different 
speaker talks? (Hint: Make Video Follow 
Speaker) 
 
Explore the Audio & Video Options menu 
to see other choices. 
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Test Your Knowledge: Communication  

 
Test your knowledge by circling true or false to answer the statements: 
 

T F 
It is recommended to visit the Audio Setup Wizard at the start of every 
session. 

T F 
The Audio Setup Wizard is accessed by clicking the Audio Setup Wizard 
button located in the Audio & Video panel. 

T F The Feedback options or emoticons can be disabled. 

T F 
The Step Away button will mute your computer and keep you from seeing 
screen changes until you click the button to rejoin. 

T F 
When the Raise Hand button is used, the moderator will see a number next 
to the participant’s name. 

T F 
When a participant’s audio permission is removed, the talk button becomes 
grayed out and inactive. 

T F 
An orange and/or red indicator light will appear next to the audio permission 
when there is a delay in receiving audio. 

T F 
One sign that your Talk button has been enabled is that a microphone 
graphic will display on the Talk button. 

T F 
While using the simultaneous talkers, it is strongly recommended that each 
participant use a headset in order to avoid an echo. 

T F 
If a participant’s chat permission is removed, communication to everyone in 
the session is cut off. 

T F Participants will be able to see all public and private chat messages. 

T F 
To send an announcement, follow these steps:  Click the Chat options menu 
and select Send Announcement... 

T F 
When using a webcam, the word PREVIEW across the video screen, 
indicates that the video is not being transmitted to others. 

T F The maximum simultaneous cameras in a session are five. 
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 My Notes 
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Part Four: Classroom Interaction 

 
In a traditional classroom setting, you might manage interaction with your students by 
asking dichotomous questions, asking for a show of hands, reading nonverbal 
communication, having one student present a portion of the content, or using small 
group activities. You can employ the same management methods in a Blackboard 
Collaborate session. Permissions can be managed on an individual and a global level. 
This flexibility allows you to manage your session in the manner that best suits your 
instructional style. 
 

If You Want to… Use This 

Ask a question that requires a yes or no 
response. 
 
Ask Participants to click the green check 
for Yes and the red x for No. 

 
Have a show of hands to get a quick 
count or to have Participants raise their 
hand to indicate that they have a 
question. 
 
Ask Participants to click the Raise Hand 
button. 

 

Encourage Participants to give a 
nonverbal indication of their reactions 
during the session. 
 
Ask Participants to click the Feedback 
menu. 

  
Indicate you have stepped away from the 
session or are temporarily distracted and 
unable to participate.  
 
Ask Participants to click the Step Away 
button. 
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Test Your Knowledge: Classroom Interaction 

 

 
 

Based on the screen shot of the Participants panel, explain the session permissions 
Dominic, Emma, Jacob and Sophia have and which permissions have been taken 
away. 
_____________________________________________________________ 
_____________________________________________________________ 
_____________________________________________________________ 
 
Explain how the Moderator can control Global and Individual permissions?  
_____________________________________________________________ 
_____________________________________________________________ 
_____________________________________________________________ 
 
Based on the graphic above, which permissions have been managed at the individual 
level? 
_____________________________________________________________ 
_____________________________________________________________ 
_____________________________________________________________ 
 
Which session tools and features cannot be disabled by the moderator during the 
session? 
_____________________________________________________________ 
_____________________________________________________________ 
_____________________________________________________________ 
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Test Your Knowledge: Classroom Interaction continued… 

 

 
 

What actions might a moderator take to address red and orange indicator lights? 
_____________________________________________________________ 
_____________________________________________________________ 
_____________________________________________________________ 
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 My Notes 
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Part Five:  Polling 

 
At any time during your session, you can poll the attendees using different polls. By 
default, the Yes/No poll will be available with the corresponding response buttons 
displayed above the Participants list. The types of polls available are Yes/No and 
Multiple-Choice (Responses A – C, A – D, A – E). You may change the type of poll at 
any time – the response buttons will change. 
 

 
 

 
 

 
 
 

 
 
 

The Polling type is changed by selecting Polling Type from the Global Options menu 
located in the Participants panel. The moderator may also choose to make the 
responses visible to all participants or only to the moderator by selecting or deselecting 
“Make Responses Visible.” The responses can also be locked thereby prohibiting 
participants from changing their response. Finally the results from the poll can be 
published to the Whiteboard.  The results are an anonymous graphical representation of 
the poll. 

 
 

The polling results can be saved or printed by saving or printing the Whiteboard page.  
Choose WBD or WBP to reuse the page in a future session. Select PDF to view the 
page outside of a session. 
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Practice: Polling 

 
For the following practice, you will need to log into a session as a moderator, then log 
into the same session as a participant two more times or team up with a partner.  You 
will now have a total of three people in the session, one moderator and two participants. 
This will provide practice as a moderator and will enable you to view what a participant 
sees. 
 

 

 

 From the Global Options menu 
change the Polling Type to A..E 
Multiple Choices.  

 What happened to the polling 
response button? 
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Practice: Polling continued… 

 

  

 Change the poll back to Yes/No. 
click on the green check as a 
participant. What happened? 

 As a moderator, clear the 
responses. 

  Deselect Make Responses 
Visible.  Click the Yes/No as a 
participant. Compare the 
moderators view to the 
participants view.  How is it 
different? 

 

 Select Lock Responses.  What 
happened for participants? 

  Have the participants register a 
polling choice. Now select 
Publish Responses to the 
Whiteboard. What happened? 

 

 
Test Your Knowledge: Polling 

 

T F  The default is to Show poll responses to moderators only. 
 

T F  The results of the poll can be published to the Whiteboard. 
 

T F  Just like the emoticons, polling tools cannot be turned off. 
 

T F 
 The polling responses can be saved or printed?  

 How? _____________________ 
 

  



30 
© Materials License 

Part Six: Session Content - PowerPoint and the Whiteboard 

 
Whether you are facilitating a meeting, presenting a webinar, leading a training session 
or teaching a class, you will need to include content in the session.  Content can be 
shared with Participants in a number of ways. In this section we will focus on importing 
PowerPoint to the Whiteboard and dynamically creating content using the Whiteboard 
tools.  

Whiteboard 

The Whiteboard is the primary content display area in a session.  New Whiteboards or 
Pages can be added by the Moderator at any time during a session.  Presentations, 
such as PowerPoint, can be loaded to the Whiteboard.  These presentations are 
converted into images and displayed across a series of pages.  The Whiteboard tools, 
such as the pen, highlighter and text tools, are available to enhance the content on the 
screen.  When content is loaded into the session, the Page Explorer will open.  The 
Moderator can choose to navigate the pages using the Page Explorer or close it and 
have the page navigation buttons appear at the top of the Whiteboard.  
 
Another key feature of the Whiteboard, available to the Moderator, is Explore Mode.  
Explore Mode allows the Moderator to explore or view other pages while locking 
Participants on the current page. 
 

Explore Mode Off Explore Mode On 

  
 

 

Whiteboard Tips 

When PowerPoint is loaded into a session, it is converted into a Whiteboard page.  As 
such, each slide is: 

 converted into an image 

 static i.e. no animations or transitions 
 

The converted PowerPoint content, now in Whiteboard (WBD) or Protected Whiteboard 
(WBP) format, will load much quicker into future sessions than PowerPoint.  The 
Whiteboard has a 20 MB limit which is not a 1:1 PowerPoint file size to Whiteboard file 
size conversion ratio.  Therefore large PowerPoint files should be converted prior the 
session to ensure they are file size compliant.  If the file is too big, divide the 
PowerPoint into multiple files and create multiple Whiteboard files.  Load the 
Whiteboard files into the session as needed deleting the completed content.  Finally, 
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Whiteboard files also maintain the interactive features of the object-oriented whiteboard 
and URLs added to pages using the Whiteboard text tool.   

 

Practice: Whiteboard 

 

Log into a session as a moderator. You will need a PowerPoint file for practice. 

 
 Click the Load Content. 

  Locate your PowerPoint file 
and click Open. 

 

 

 Use the Page Explorer to 
cut, copy or paste a page 
and to create a new page. 
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Practice: Whiteboard continued…  

 

 

 Close Page Explorer and 
located the navigation 
tools. 

 

 With at least one 
participant logged into the 
session, practice turning on 
and off Explore mode. 

 What happens? ________ 
 

 

 

 Explore all of the 
Whiteboard tools and their 
properties.  
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Practice: Whiteboard continued… 

 

 

 
 

 
 

 

 Create a new page and 
add Clip Art to the page. 

 

 

 Save the Whiteboard to 
WBD format. 
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Test Your Knowledge: Whiteboard 

 
Draw a line from the tool on the left to match the label on the right. 

 

Screen Capture Tool 
Pointer Tool 
Ellipse Tool 
Selection Tool 
Pen Tool 
Text Editor Tool 
Clipart Library 
Filled Rectangle Tool 
Line Tool 

Circle the file type on the left to match the definition on the right. 

WBD, WBP, PDF, PNG 
This file type can be used in a session 
disabling participants to print or save the 
Whiteboard pages. 

WBD, WBP, PDF, PNG 

This file type will allow users to reuse 
content future sessions.  It will retain the 
object orientation, animated clipart and live 
links. 

WBD, WBP, PDF, PNG 
This file type will enable a person to view a 
slide outside of a live session. 

T F 
Pages can be renamed from within the 
web conferencing session. 

T F 
New pages can be added anytime into a 
live session. 

T F 
A Participant can delete other participants 
and even the Moderators whiteboard 
contributions. 
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Part Seven: Recording a Session  

 
As a Moderator, you can record a session and play it later.  Recordings are stored on 
the Blackboard Collaborate server.  Playback is available from a LMS/CMS, URL or by 
logging into the Blackboard Collaborate administrative server.  You may want to provide 
access to the recording to those who missed the session or to those who attended but 
would like to review the session. Or you may want to record sessions for archival 
purposes. All activity that occurs in the main room of the session will be recorded, 
except for private Chat messages, the Timer and personal Notes. As the recording 
progresses, Blackboard Collaborate inserts index entries to mark significant events 
within the session. Anyone viewing the recording can navigate through the recording to 
points marked with index entries. You can start or stop recording at any time during the 
session. You also can erase the recording at any time during the session. 
 

  
Moderator button to start 
recording. 

 
 Moderator button to 
pause/stop recording. 

  
Participant indicator 
that the session is 
being recorded. 

 
Recording Reminder 
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Part Eight: Tips on Leading a Session 

 
In most cases the session moderator is the curriculum developer, session designer and 
session facilitator or presenter.  They manage content and interaction, facilitate 
communication and collaboration, and build community and confidence.  Most 
importantly, a moderator practices the tasks commonly performed by presenters and 
designers, and then puts those tasks together with an effective and engaging delivery 
style. 

A Moderator: 

 Develops a plan and designs the session 

 Prepares participants and the presentation 

 Presents the content while managing interaction and facilitating communication 

 Assesses session effectiveness 
 

Developing a Plan and Designing the Session 

Great coaches have a game plan; great moderators have a robust presentation plan.  
This plan provides a framework that helps determine the when, why, and how behind 
what content is presented.  It also helps identify what materials and resources you 
already have available and what you will need to develop.  The plan also provides a 
place to note what you want to say about each content item, which helps jog your 
memory when it’s time to deliver the content. Consider using Blackboard Collaborate 
Plan to accomplish these goals. 
 
When preparing your session, remember that Blackboard Collaborate web conferencing 
is designed to meet the needs of all types of learners: visual, auditory, kinesthetic, and 
social.  Vary both the content format and the target areas to keep participants engaged.  
Know your learning and social objectives, and select content that supports these 
objectives.  Doing so keeps the presentation on track and lessens confusion. 
 

Preparing Participants and the Presentation 

Once you have created the classroom and prepared the content, it is time to invite 
participants to attend the session.  You will need to provide participants with information 
about the session so they know when to show up, how to log in, what to do if they 
encounter technical difficulties, and what is expected of them once they arrive.  As the 
session leader, be ready to present.  Perform an equipment and environment check 
ahead of time to ensure a smooth session.   
 

Presenting Content While Managing Interaction 

Presenting content, while managing interaction and facilitating communication, requires 
multitasking skills.  Having a plan is a great starting point, but the plan alone isn’t 
enough.  Just as a coach occasionally needs to make a last-minute adjustment to a 
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play, a moderator may occasionally need to make adjustments to the plan in the middle 
of a session.  Spontaneity and the ability to improvise are crucial skills for the session 
leader, and they are developed through practice. 
 

Assessing Effectiveness 

Asking your participants for feedback during a session is a great way to assess both the 
flow and effectiveness of the content.  At the end of the session, take the time to 
evaluate the effectiveness of the session on the whole.  By focusing on both his/her 
strengths, and areas for improvement, a leader can then make the necessary 
adjustments to increase effectiveness for the next time he/she delivers a session.  
 

Ready to Deliver a Live Session 

Now that you are ready to deliver a live session, you will need to inform participants and 
guests of the following: 

 Time and date of the session 

 Classroom access information 

 Technical Support contact information 
 
You may already have a web conferencing room in which case simply send the 
Participant or Guest URL to your invitees.  If you are using Blackboard Collaborate 
integrated with a course or learning management system, then log into your course and 
create the session.  Finally, if you have access to the Blackboard Collaborate 
administrative system (SAS or ELM), then log into that system and create your session.  
The participant URL and the recording URL will be generated when you create the 
session.  
 

Pre-Session Tips 

Whether you are presenting your session from your home or office, or from a class or 
boardroom setting, preparing your equipment and environment will ensure an optimal 
experience for all. 
 

Equipment Check: 

 Computer configuration has been verified  

 Microphone is in good working order 

 Headset or speakers are working properly 

 Camera is working properly 
 

Environment Check: 

 Telephone ringers have been turned off 

 Noise has been lessened as much as possible 

 Workstation is ergonomically correct 
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 Lighting is sufficient for cameras, but does not cause eye strain 

 Comfort items are nearby, for example:  beverage and tissues 

 Pen, paper, calculator, etc. are within reach 
 

Presentation Tips 

 Practice – use speaking notes to help you stay on track 

 Relax – you are human and that’s OK.  Remember, “people teach people” 

 Talk the walk – tell participants where they are and where they are going 

 Take your time – be aware of varying connection speeds, and leave no 
participant behind. 
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Part Nine:  The Blackboard Collaborate Experience 

 
Although this is the last part of this training manual, it is just the beginning of your 
Blackboard Collaborate experience.  In order to help you make the most of this training, 
please take a few moments to reflect on the following questions and suggestions. 
 

 How will you incorporate Blackboard Collaborate web conferencing into your 
learning environment? 

 Which features and functionality of Blackboard Collaborate are best suited to 
help you achieve your learning objectives? 

 What methods of evaluation will you use to determine if the learning objectives 
have been met? 

 Who will comprise your support system as you implement Blackboard 
Collaborate? 

 What methods will you use to communicate your successes to your students, 
your institution, your colleagues, and other Blackboard Collaborate users? 

 
Visit the On-Demand Learning Center for full product documentation, Quick Reference 
Guides, recorded tutorials and more:  

http://tinyurl.com/BbCOnDemandLearning 
 
 
Thank you for your participation in this workshop.  We wish you the greatest success in 
your educational journey with Blackboard Collaborate. 
 
The Blackboard Collaborate Learning Services Team 
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Test Your Knowledge: Overview – Answer Key 

 
Test Your Knowledge: Overview 

Test your knowledge of the web conferencing interface by matching the screenshot on 
the left to its correct description on the right.  You can find the answer key in the last 
section of the manual. 
 

1. 
E 

 
 

 

A 
The moderator is able to 

grant a participant permission 
to annotate in this area. 

2.  
A 
 

 

 
 

 

B 
From this area moderators 

can control participant 
permissions on either an 
individual or global level. 

 

3. 
B 

 

 

C 
From this area a participant is 

able to turn on and off their 
microphone. 
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4. 
C 

 

 

D 
The moderator can start and 
pause the session recording 

from this area.  

5. 
D 

 

 

E 
Participants can send public 

and private text chat 
message in this area. 
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Test Your Knowledge: Communication  

Test your knowledge by circling true or false to answer the statements: 
 

T F 
It is recommended to visit the Audio Setup Wizard at the start of every 
session. 

T 
F 

The Audio Setup Wizard is accessed by clicking the Audio Setup Wizard 
button located in the Audio & Video panel. 

T F The Feedback options or emoticons can be disabled. 

T F 
The Stepped Away button will mute your computer and keep you from 
seeing screen changes until you click the button to rejoin. 

T F 
When the Raise Hand button is used, the moderator will see a number next 
to the participant’s name. 

T F 
When a participant’s audio permission is removed, the talk button becomes 
grayed out and inactive. 

T F 
An orange and/or red indicator light will appear next to the audio permission 
when there is a delay in receiving audio. 

T F 
One sign that your Talk button has been enabled is that a microphone 
graphic will display on the Talk button. 

T F 
While using the simultaneous talkers, it is strongly recommended that each 
participant use a headset in order to avoid an echo. 

T 
F 

If a participant’s chat permission is removed, communication to everyone in 
the session is cut off. 

T F Participants will be able to see all public and private chat messages. 

T F 
To send an announcement, follow these steps:  Click the Chat options menu 
and select Send Announcement... 

T 
F 

When using a webcam, the word PREVIEW across the video screen, 
indicates that the video is not being transmitted to others. 

T F The maximum simultaneous cameras in a session are five. 

  



43 
© Materials License 

 
Test Your Knowledge: Classroom Interaction 

 
 

Based on the screen shot of the Participants panel, explain the session permissions 
Dominic, Emma, Jacob and Sophia have and which permissions have been taken 
away. 
Dominic has all of the Global permissions except Chat has been removed just for 
Dominic. Emma has been given Web Tour permission. Jacob has been given 
Application Sharing permission but audio has been taken away.  Sophia has been 
give permission to use Closed Captioning however the Whiteboard permission 
has been taken away. 
 
Explain how the Moderator can control Global and Individual permissions?  
Global permissions are managed from the Options menu located at the top of the 
Participants panel.  Individual permissions are managed by from the Options 
menu for each participant. 
 
Based on the graphic above, which permissions have been managed at the individual 
level? 
Chat, audio and whiteboard. 
 
Which session tools and features cannot be disabled by the moderator during the 
session? 
Emoticons, step away, and raise hand cannot be disabled. 
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What actions might a moderator take to address red and orange indicator lights? 
If the lights are associated with the audio, the Moderator should stop speaking, 
turn off the microphone and wait until the lights disappear.  If they are associated 
with one of the other session tools, simple pause what you are doing, i.e. stop 
making changes to a shared application and wait for the lights to disappear. 
 

 
Test Your Knowledge: Polling 

 

T F 
 The default is to Show poll responses to 

moderators only. 
 

T F 
 The results of the poll can be published to the 

Whiteboard. 
 

T F 
 Just like the emoticons, polling tools cannot 

be turned off. 
 

T F 

 The polling responses can be saved or 
printed?  

 How? Save the Whiteboard – File > Save > 
Whiteboard 
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Test Your Knowledge: Whiteboard 

 
Draw a line from the tool on the left to match the label on the right. 

 

Screen Capture Tool 
Pointer Tool 
Ellipse Tool 
Selection Tool 
Pen Tool 
Text Editor Tool 
Clipart Library 
Filled Rectangle Tool 
Line Tool 

Circle the file type on the left to match the definition on the right. 

WBD, WBP, PDF, PNG 
This file type can be used in a session 
disabling participants to print or save the 
Whiteboard pages. 

WBD, WBP, PDF, PNG This file type will allow users to reuse 
content future sessions.  It will retain the 
object orientation, animated clipart and live 
links. 

WBD, WBP, PDF, PNG 
This file type will enable a person to view a 
slide outside of a live session. 

T F 
Pages can be renamed from within the 
web conferencing session. 

T F 
New pages can be added anytime into a 
live session. 

T F 
A Participant can delete other participants 
and even the Moderators whiteboard 
contributions. 
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